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OFFICE 2007 TERMINOLOGY
The latest version of Microsoft Office for Windows – Office 2007 – looks very different from
Office 2003. While it has much of the same functionality as the previous version, you have to
learn where to find the tools you are used to using (Note: most keyboard shortcuts are exactly the same, so
if you are accustomed to using those, carry on!).
In addition to visual changes, Microsoft has introduced some new terminology.
Office Button: located in the upper-left corner of the screen, the Office
Button replaces much of what was in the File menu, such as Open, Close,
Print, Save, etc. Click once on the Office Button and the list will display as at
the right. At the bottom of the window, you’ll see an Options button. This
replaces the Options menu that was located in the Tools menu.
Quick Access Toolbar (
): By default, the Quick Access Toolbar is
located to the right of the Office Button. You can customize it by adding other
icons you are used to seeing in the Office 2003 toolbars.
Ribbon: The Ribbon replaces the Office 2003 toolbars, and it changes
contextually, assembling icons into logical groups. Below is the Home Ribbon
in Word. Note that is has many of the features of the Office 2003 Standard and
Formatting Toolbars, as well as new features such as the Style Group.
The Expand icon, which sits in the lower-right corner of some groups, displays even more
options, often looking the same as the traditional Office 2003 dialog boxes.
Click here for the Home Ribbon.

This is the Styles Group.

This is the Expand icon.

Extensions/File Types: This new version of Office uses an XML-based file format, and you
can see that the default extensions now end with an ―x‖ - .docx, .xlsx, and .pptx. If you are sharing
files with people who have Office 2003 (or Office 2004 for Macintosh users), you can save the
document in the older format, and even change your default to that older format.

GETTING HELP WITH WORD 2007
If you have other questions about Word 2007 or other software products, contact the Faculty
Exploratory or the Knowledge Navigation Center. The contact information for both is at the
bottom of each page of this document (known as the ―footer‖).
Need help? Visit the Faculty Exploratory or Knowledge Navigation Center on the 2nd floor of the Graduate Library.
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STYLES
Your Word documents are likely to have a few categories of text that need to appear differently.
These categories may include body text (the words in each paragraph), headings and subheadings,
chapter titles, blocked-off quotes, and more. You can specify what each category of text should
look like by creating or redefining a style.
A Word style is a combination of formatting characteristics. For example, you can specify that all
of the quotes in your document to be single-spaced, have 6 points of space above and below
them, and are indented by .5‖ on either side. You can specify that you want your primary
headings to be centered and bold, and your subheadings should be left-aligned and italicized.
Rather than formatting each heading or quote one-by-one throughout your entire document, you
can use styles to specify what each category of text should look like, and then apply these styles to
your text as needed.
To see a list of the predefined styles in Word, go to the Styles Group in the Home Ribbon, and
click on the Expand icon. To make building an automatic table of contents easier, you should
redefine the Heading 1, Heading 2, etc. rather than create new styles that perform these functions.

CHOOSING WHICH STYLES TO USE
We highly recommend using the built-in styles that come with Word 2007 because some other
functions (like tables of content or tables of figures) use them automatically. Even if you don’t
like the way they look, their appearance can be edited to fit your own needs. (See the Modifying a
Style section on page 4).
For main headings or chapter titles, use Heading 1. For subheadings, use Heading 2,
and so on. (Note: Headings 3 and above may not appear in your list of styles until you’ve used Heading
1 and Heading 2.) Headings are used in automatic tables of contents.
For body text, use Normal. This is the default for Word; if you start typing without
specifying a style, it will be in the Normal style.
For figures, tables, etc. use the Caption style, as it is used in the automatic table of figures.

APPLYING A STYLE
1. Select the text to which you want to apply a style.
2. In the Home Ribbon, in the Style Group, click on the style you want to apply. If you
don’t see the style you want to use, click on the Expand icon on the Style Group to see a
more complete list.
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MODIFYING A STYLE
You can change the appearance of a style, including its line
spacing, font, color, alignment… just about anything! If you
change a style, that change will affect all text in your document in that style.
1. On the Home Ribbon, in the Styles Group, right-click
on the style you want to change, and select Modify. If
you don’t see the style you want to change, click on the
Expand icon to see a more complete list.
2. In the Modify Style dialog box, you can make any
change you want to the style.
3. Click on the Format button in the bottom-left corner of
the dialog box for even more options such as font,
paragraph, numbering, etc.

TEMPLATES
Templates are useful for remembering the modifications you make to the margins, styles, and
automatic numbering features in your document. Rather than setting up your styles in each and
every document you create, you can set them up once in a template, and then create each new
document based on that template.

CREATING A TEMPLATE
1. Open a blank Word document and adjust your styles, margins and any automatic
numbering features you want in your document.
2. Click on the Office Button (remember, upper left corner of the screen), select Save as…,
then select Word Template. Save it somewhere that you can find easily.
3. To modify your template later, open Word first, then open the template file – if you
double-click on it, it will create a new document based on the template as described below.

USING YOUR TEMPLATE
1. Double-click on the template file you created in the steps above. This will open a new
document based on that template.
2. If you have already written text, you can insert it into this new document to apply style
settings. To do this…
a. On the Insert Ribbon, in the Text Group, click on the arrow next to the Object icon
and select Text from File….
b. Navigate to and select the file you wish to insert, then click the Insert button.
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INSERTING REFERENCES
There are a variety of references that you may need in your document – endnotes or footnotes,
captions, and cross-references. All of this can be done with the References Ribbon.

INSERTING FOOTNOTES AND ENDNOTES
You can use footnotes and endnotes to link notes or citation information to your text without
cluttering your document. Footnotes are linked to the bottom of the page, while Endnotes link
to the end of the document.
3. Put your cursor where you want to insert your new footnote or endnote.
4. In the Footnotes Group, click either the Insert Footnote or Insert Endnote icon to create
a new footnote or endnote, respectively. (If you use the program EndNote, you’ll want to
use the EndNote Ribbon instead. See our EndNote handout for more information).
5. To adjust the settings of your footnote, including the numbering style, when to start and
stop the numbering of your notes, and more, click on the Expand icon in the Footnotes
Group of the References Ribbon.
Note: You can have your footnotes and endnotes restart their numbering in each chapter. To do this, each chapter
will need to be a separate section.

INSERTING CROSS-REFERENCES
To refer to other sections of your document, insert a Cross-reference.
1. Place the cursor where you would like to insert your reference
and click the Cross-reference icon in the Captions Group.
2. Choose what you want to reference (heading, figure, etc.).
Examples that exist in your text will appear in the box below.
Click on the correct one.
3. Choose what you want to display (the page number, the heading, etc.).

INSERTING CAPTIONS
Insert Captions to label and describe pictures, tables, and other
objects in your documents. Change the font, etc. of captions like
any other style.
1. Click on the Insert Caption icon in the Captions Group.
2. Insert the text you would like in your caption.
3. Click the Numbering… button to change how the caption
is formatted, and if you want to include chapter numbers.
4. Click OK to close the dialog box. Caption numbers should automatically update when you
add new figures.
Need help? Visit the Faculty Exploratory or Knowledge Navigation Center on the 2nd floor of the Graduate Library.
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INSERTING IMAGES
Images, pictures, graphics – whatever you call them, they can enhance your Word document by
providing visual information to the reader. These can include scanned pictures or photographs,
and ClipArt. Word can handle a variety of image file types, but the types might differ in file size. If
the image you have isn’t in one of these formats, you can convert to an acceptable format using a
software program like Photoshop. On the Insert Ribbon, in the Illustrations Group, select the
type of object you want to insert.

RESIZING AND MOVING IMAGES
After you have inserted your image, you can resize it and move it anywhere in your document.
Make sure it is selected (click on it once) to do the following:
To move your image, click and drag it to the desired location.
To resize the image, click and drag one of the little circles that appear in the corners –dragging
from the corner keeps the image proportionate. Note that depending on the file type, your image
may become distorted if you make it bigger.
To rotate the image, click and drag on the green circle at the top.
To crop the image, click the Crop icon in the Format Ribbon. Cropping handles will appear—
move these by clicking and dragging, and the image will automatically be cropped. Note that
unlike a program like Photoshop, the cropped image is still in the document unless you compress
the image (as described below). You can get the cropped area back by clicking the Reset Picture
icon in the Adjust Group.
To compress the image, click the Compress Pictures icon in the Format Ribbon.

You can also format the brightness, contrast, and color from the Format Ribbon, as well as play
with different image displays called Picture Styles (move your mouse over them to preview how
they would affect your image).

WRAPPING TEXT AROUND YOUR PICTURE
Once you’ve inserted a picture (ClipArt or other), you may want to change the way it looks in
relation to your text. By default the picture is inserted in line with the text. To change the
wrapping,
1. Select your picture. The Picture Tools Format Ribbon will appear. It contains format
options for your image or ClipArt.
2. Click on the Text Wrapping icon in the Arrange Group, and choose from the menu.
Need help? Visit the Faculty Exploratory or Knowledge Navigation Center on the 2nd floor of the Graduate Library.
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You may notice when you return to your document that the picture has ―bounced‖ to somewhere
else in the page. Click and drag it to where you’d like it to be, or click on the Position icon. Use
More Layout Options to fine-tune your picture’s position of text-wrap settings.

CREATING A SCREEN SHOT
Also known as a ―screen capture‖ this technique allows you to capture a picture of what shows on
your screen (for example, you may want to insert a screen shot of a web page into your
document). Once the picture is in your document, it’s just like any other picture that can be
resized, have text wrapped around it, and so forth.
If you press F13 on your keyboard, it takes a picture of what ever is showing on you computer (so
any open window will display) and places it on the clipboard. Back in your document, put your
cursor where you’d like to insert the screen shot, go to the Home Ribbon, and select the Paste
button in the Clipboard Group.

INSERTING CHARTS
When you want a chart in your document, you have a few options. Clicking the Charts icon (
)
prompts you to add data for a new chart. If you’ve already created a chart in Excel, you can copy
and paste it from Excel into Word. When you do this (copy and paste), editing the data from the
chart in Word actually changes the original Excel document. On the Home Ribbon, click the Edit
Data button in the Data Group to edit the data of a selected chart. If you edit your data in Excel,
click the Refresh Data button in Word to see an updated version of your chart.

An alternate method is to use the Paste Special command, which allows you to insert your chart
as a JPEG (or other picture file, such as GIF or PNG). This makes the data non-editable, and the
Word document and the Excel document will not be linked (editing data in one won’t affect the
other). To paste your chart as a picture:
1. Go to the Clipboard Group on the Home
Ribbon. Click and hold the arrow under the
Paste icon and choose Paste Special… from the
drop-down menu. The Paste Special dialog
box will appear.
2. Select Picture (JPEG) from the Paste As: list.
3. Click OK when you are done.
Remember, if you paste your chart as a picture, it will
not be linked to your original data.
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SECTIONS
Sections allow you to create landscape pages within a portrait document and insert page numbers
with greater control. There are a few different kinds of sections that you may need:
Use an Odd page or Even page section break if the page numbers aren’t lining up as
you’d like.
Choose Continuous if you don’t want a new page for your section but for some reason
need a section break (for example, two columns for part of the text on the page).
Select Next page if you want a new page.
If you can’t see what section you are in, you can change the Word document settings to show you.
Along the bottom of your Word document is the Status Bar. At the left end of this bar, Word
tells you what page you are on, how many words are in your document, which section you are in,
and so on. To the right end of the bar, you can click on the various views (Print Layout, Outline,
etc.) as well as zoom in and out. To add the section information to the Status Bar, right-click on it,
and select Section in the menu that appears.

CREATING A LANDSCAPE SECTION
You can make a landscape section of pages in your portrait document, and move the page number
if necessary (see the Page Numbers on Landscape Pages section on page 10).
1. Click on the last line of the page before the page you want to have landscape orientation.
2. On the Page Layout Ribbon, in the Page Setup Group click on the arrow next to the
Breaks icon and select Next Page under the Section Breaks section.
3. Repeat step 2 again to create another blank page.
4. Use the Delete key, not the Backspace key (sometimes called the backwards delete key), on the
keyboard to bring the next page’s content back up to the page you are currently on if
necessary.
5. Click on the blank page created in step 2.
6. On the Page Layout Ribbon, in the Page Setup Group, click on the arrow next to the
Orientation icon and select Landscape.
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EDITING HEADERS OR FOOTERS
Text that appears in the top or bottom margin of a page is referred to as the ―Header‖ or
―Footer,‖ depending on its placement. Headers and footers often give information about the
document, such as the author, title, section title or page numbers.
Go to the Insert Ribbon to access the Header and Footer Group. When you click on either the
Header or Footer icon and select Edit Header (or Footer) from the pull-down menu, a new ribbon
will appear, called Design. With this toolbar, you can add page numbers, dates, and so forth, as
well as view the next or previous header or footer, switch between header and footer, etc. Clicking
on the Header or Footer button will activate a drop-down menu of different Header and Footer
templates. Choosing a template (Blank will allow you to create your own format), will return you
to the Header/Footer area of your page. Click your mouse where you want to insert text and
either begin typing or click the appropriate item on the toolbar (such as page number).

USING SECTIONS TO CONTROL PAGE NUMBER FORMAT
You can set the page numbers for your entire document, or if you need more control, you can do
it section-by-section as well. For example, front matter (such as dedication, acknowledgements,
etc.) may need Roman numerals and in the main text Arabic.
1. Click to the left of the first character of the new section you would like to make. On the
Page Layout Ribbon, in the Page Setup Group, click on the arrow next to the Breaks
icon and select Next Page under the Section Breaks section.
2. On the Insert Ribbon, in the Header & Footer Group, click on the arrow under the
Footer icon and select Edit Footer.
3. Check which section you’re in and make sure you are in the correct location. If you were
to insert page numbers now, page numbers would go into your entire document, and they
would all be the same (Arabic or Roman). We need to unlink this section’s Header and
Footer from other sections’ Headers and Footers.
4. In the Header & Footer Tools Design Ribbon, in the Navigation Group, click the
highlighted Link to Previous icon to unlink this section’s footer from previous section.

5. Still in this Ribbon, go to the Header & Footer Group, click on the
Page Number icon and select the positioning you’d like. Generally,
Bottom of the Page is the choice, and either Plain Number 2 or 3.
6. To change to Roman numerals, click on the Page Number icon and
select Format Page Numbers…. Choose the correct format in the Number
format: pulldown menu and then click OK.
7. In the Navigation Group of the Header & Footer Tools Design
Ribbon, click on the Next Section icon and repeat these steps to put the
Arabic numbers in the next section.
Need help? Visit the Faculty Exploratory or Knowledge Navigation Center on the 2nd floor of the Graduate Library.
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PAGE NUMBERS ON LANDSCAPE PAGES
When you change the orientation of a section of page to landscape, the Header and Footer of that
section do not change orientation. Instead, the Header and Footer are at the top and bottom of
the page on your screen, but when you print, they are in the left and right margins of the page, not
the top and bottom.
Any page numbers in the Header or Footer will appear sideways on the left or right of the printed
page. These steps will help you move the page numbers to the appropriate spot and turn them on
their side so they print correctly.
1. Click somewhere in the first page of the section with landscape pages.
2. On the Insert Ribbon, in the Header & Footer Group, click on the arrow below the
Header icon and select Edit Header.
3. In the Header & Footer Tools Design Ribbon, in the Navigation Group, unlink this
section’s Header from previous sections’ headers by clicking the highlighted Link to
Previous icon.
4. Click on the Go to Footer icon and repeat step 3 for the Footer of this section.
5. Scroll down to the first portrait page following your landscape section and click in its
Header. Repeat steps 3 and 4 for this section.
You have now disconnected the headers and footers in the sections prior to and following the
landscape section of pages. This will prevent any changes you make to the page numbers on the
landscape pages from affecting the numbering on other pages.
6. Delete the page numbers from the footer of the landscape section.
7. While still in the Footer, on the Insert Ribbon, in the Text Group, click on the arrow next
to the Text Box icon and select Draw Text Box.
8. Your cursor will turn into crosshairs. Click where you want your page number to appear –
a large text box will appear there.
9. On the Insert Ribbon, in the Header & Footer Group, click on the arrow next to the
Page Numbers icon, then Current Position menu, and select Plain Number.
10. In the Text Box Tools Format Ribbon, in the Text Group, click on Text Direction icon
until the number is rotated in the right orientation.

11. In the Text Box Tools Format Ribbon, in the Text Box Styles Group, click on the arrow
next to the Shape Outline icon and select No Outline.
12. Finally, click and drag the edge of the text box to position the number where you want it
to be.
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CREATING A TABLE OF CONTENTS
You cannot generate any automatic tables without first using styles effectively throughout your
document. Microsoft Word can scan your document and find everything in the Heading 1 style
and put that on the first level of your table of contents, put any Heading 2’s on the second level of
your table of contents, and so on.
If you want an automatic table of contents you need to label all of your chapter titles and front
matter headings (e.g. ―Dedication‖ and ―Acknowledgements‖) in the style Heading 1. All major
headings within your chapters should be labeled Heading 2. All subheadings should be labeled
Heading 3, and so on.
If you have used Heading styles in your document, creating an automatic table of contents is easy.
1. Place your cursor where you want your table of contents to be.
2. On the References Ribbon, in the Table of Contents Group, click on the arrow next to
the Table of Contents icon, and select Insert Table of Contents.
3. If you want to change the style of your table of contents (e.g. you want more space
between the items on level 1 and level 2 of your table of contents, or you want all your
level 1 items to be bold), click on the Modify button, select the TOC level you want to
change, then click the Modify button to change it like any style.
4. If you want to change which headings appear in your table of contents, you can do so by
changing the number in the Show levels: pulldown.
5. Click OK to insert your table of contents.

CREATING A TABLE OF FIGURES OR TABLES
If you have captioned your figures, table and equations using Microsoft Word’s captioning feature
(see Inserting Captions on page 5 for details), you can have Word generate your lists for you
automatically.
1. Place your cursor where you want your list to be.
2. On the References Ribbon, in the Captions
Group, click the Insert Table of Figures icon
(
) (even for lists of tables and
equations).
3. In the Table of Figures dialog box, select the label
for which you want to make a list from the Caption
Label pulldown.
4. If you want to change the style of your table of
contents (e.g. you want more space between each
item in the list), click on the Modify button, select
the Table of Figures style, then click the Modify
button to do so. Click OK when you are done.
5. Click OK to insert your table of contents.
Repeat these steps to insert other lists into your document.
Need help? Visit the Faculty Exploratory or Knowledge Navigation Center on the 2nd floor of the Graduate Library.
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COMMENTING AND REVIEWING
To keep track of the suggestions that classmates or colleagues make on your document, you will
want to use Microsoft Word’s commenting and reviewing features.
Before you send your document, you should enable the Track Changes feature. Any changes your
advisors make to your document will be recorded, so you can approve or reject that change later.
On the Review Ribbon in the Tracking Group, click on the Track Changes icon to highlight it
and enable it. Then, just type in your document as normal, and any change you make will be
tracked. Different colors will represent different people commenting on the same document. The
colors will change automatically with the different users. To disable track changes, repeat this step.
Use Comments if you have a general comment rather than a specific suggestion.
To turn off the balloons, click on the Balloons icon and choose Show All Revisions Inline.

USING TRACKED CHANGES WITH BALLOONS
With balloons on, all changes
(except added text) display in the
right margin, including
comments. This includes
formatting changes such as bold,
italic, etc.

USING TRACKED CHANGES WITHOUT BALLOONS
Without balloons on, all changes are
right in the text. Move your cursor
over a comment to see a popup box
of the comment.
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MERGING COMMENTS AND CHANGES INTO ONE DOCUMENT
Once everyone has made their changes and comments, you need to
combine everyone’s documents into one final document for review.
1. On the Review Ribbon, in the Compare Group, click on
the Compare icon and choose Combine.
2. In the resulting dialog box, choose your original document
on left side and the revised document on the right side (click
on the Folder icon to browse through your files).
3. Click OK to exit the dialog box.
4. Repeat as needed
until everyone’s
documents are
combined into one.
Notice that a new,
combined document
is created each time – you only need to save the one
that has everyone’s changes together.
Each person’s changes will appear in a different color, so you
can easily see who said what. To look at the changes by a
single individual, click on the arrow to the right of the Show
Markup icon (in the Tracking Group), go down to Reviewers,
and choose the single person you want to look at.

ACCEPTING AND REJECTING CHANGES
Once you have all of the documents combined into one, you need to accept or reject all of the
changes and comments. Normally, you will reject all comments – after you address the issue!
Use the Next and Previous icons in the Changes Group of the Review Ribbon to move back and
forth to the various changes.
To accept a change, click on the changed text (or use the arrow to get to the change), and
then click the Accept icon in the Changes Group of the Review Ribbon. You can accept
all changes at once by clicking on the pulldown below the Accept icon and selecting Accept
All Changes in Document.
To reject a change, click on the changed text, and then click the Reject icon in the
Changes Group of the Review Ribbon. You can reject all changes at once by clicking on
the pulldown below the Reject icon and selecting Reject All Changes in Document.
To view what your document would look like with all changes
accepted, click on the top-most pulldown on the right side of the
Tracking Group and select Final. Note that you will still need to
accept or reject all the changes; this is just for viewing, you still need to
accept or reject all of the changes before your document is complete.
Need help? Visit the Faculty Exploratory or Knowledge Navigation Center on the 2nd floor of the Graduate Library.
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FORMAT PAINTER
The Format Painter is a quick and easy way to copy the look (indentation, formatting, etc.) from
one piece of text to another without using a style. Select the text with the formats you want to
copy. On the Home Ribbon, in the Clipboard Group, click the Format Painter button , and
click the text to which you want to apply the formats.

AUTOCORRECT TOOLS
The AutoCorrect feature automatically corrects many common typing, spelling, and grammatical
errors, and it can automatically insert text for you. For example, if you misspell with as ―wiht,‖ it
will be automatically corrected. You can also use this feature to put in commonly used phrases.
To specify AutoCorrect options, go to the Office Button, and click on Word Options. Choose
Proofing, then click the AutoCorrect Options button. A dialog box will appear with tabs for each
AutoCorrect feature.

AUTOFORMAT AS YOU TYPE
AutoFormat allows you to quickly apply headings, bulleted and numbered lists, borders,
numbers, and symbols to your text. For example, you might want to always replace straight
quotation marks with smart (curly) ones, or you might prefer not to automatically format Internet
paths as hyperlinks. In the AutoFormat
As You Type tab, you can select the
elements that you do and don’t want,
and Word will apply your preferences. If
you wish to format the entire document
after you’ve finished writing it instead of
as you type, select the elements you do
and don’t want in the AutoFormat tab.

AUTOCORRECT
AutoCorrect will automatically make the
changes to incidences that are checked
in this box. You can add text to the
Replace text as you type list by typing in the
text you want replaced in the Replace:
field and putting the new text in the Width: field.

Need help? Visit the Faculty Exploratory or Knowledge Navigation Center on the 2nd floor of the Graduate Library.
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